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1. Foreword

Thank you for using the M-Bus OPC server. This easy-to-use software makes it easy to connect M-Bus meters 
to OPC-based visualization systems.

SUPPORTED OPERATING SYSTEM VERSIONS
• Windows® Server 2012 R2
• Windows® 7 32 bit / 64 bit
• Windows® Server 2008 R2 64 Bit
• Windows® 2008 Server 32 Bit / 64 Bit
• Windows® 2003 Server 32 Bit / 64 Bit
• Windows® Vista 32 bit / 64 bit

REQUIRED HARDWARE
The hardware you need is an IBM-compatible PC. As a minimum, we recommend a Pentium processor, at least 
133Mhz and 32 MB RAM memory as well as a CD-ROM drive. The installation requires approx. 15 MB free 
memory on the hard disk. A free USB port is required to operate the software protection plug (dongle).

mailto:info@mbs-software.de
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2. Literature References

European standard EN 1434-3 

Interesting links on the subject of M-Bus on the World Wide Web 

• www.m-bus.com
Information on the European Standard, company directory

• www.relay.de
Information about M-Bus level converters

2.1 REGISTERED TRADEMARKS 
Trademarks and product names of various companies are used in this book. The following names are registered 
trademarks of the respective manufacturers and are not listed separately in this book: 

• Microsoft, Windows and MS-DOS are registered trademarks of Microsoft Corporation
• Intel and Pentium are registered trademarks of Intel Corporation
• IBM-PC and IBM-AT are registered trademarks of International Business Machines Corporation

The M-Bus logo is a trademark of the M-Bus Usergroup, Paderborn and was kindly made available to us. 

2.2 COPYRIGHT 
©2012MBS GmbH | Römerstraße 15 | D-47809 Krefeld 

Phone: +49 / 21 51 / 72 94 - 0 
Fax: +49 / 21 51 / 72 94 - 50

E-Mail: info@mbs-software.de
Internet: http://www.mbs-software.de

All rights reserved. No part of this book may be reproduced in any form (print, photocopy or any other process) 
or processed, copied or distributed using electronic systems without the written permission of MBS GmbH. 

2.3 DOCUMENT REVISION 

REV. NO. DATE AUTHOR REMARK 

0.1 09.02.2012 ane -- 

mailto:info@mbs-software.de
http://www.m-bus.com/
http://www.relay.de/
mailto:info@mbs-software.de
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3 M-Bus basics 

M-Bus is specified in the European standard as EN 1434-3. For connection to PCs, various manufacturers offer
level converters that convert the M-Bus to a serial RS232C interface.

3.1 LEVEL CONVERTER 
A bus is a serial interface to which an M-Bus level converter is connected. Power is supplied to the M-Bus 
meters via the same 2-wire connection cable that is also used for communication, i.e. reading the meters. Level 
converters are available for different meter quantities; the maximum number of meters per level converter 
depends on the number of M-Bus standard loads. One M-Bus standard load is 1.5mA. Important note: When 
designing your project, please bear in mind that meters can also take up more than one standard load. 

3.2 SERIAL DEVICE SERVER 10BASET TO RS232C 
The Serial Device Server enables the connection of level converters with RS232C interface to the 10BaseT 
Ethernet. In conjunction with Windows drivers for virtual COM ports, M-Bus data can be transmitted to the M-
Bus OPC server via Ethernet routes. The physical Ethernet interface is converted to RS232C and the TCP/IP 
protocol to the serial V24 protocol. The virtual COM ports created by the driver are managed by the M-Bus 
OPC server in the same way as physical interfaces. 

3.3 ADDRESSING M-BUS 
 There are two basic types of addressing: 
• Primary addressing: A maximum of 250 meters can be connected per bus; each meter is assigned a unique

meter number from 1-250 during project planning.
• Secondary addressing: More than 250 meters can be addressed via the secondary address.

The M-Bus OPC server supports both types of addressing. 

3.4 ADDRESSING OPC 
OPC (Ole for Process Control) is a specification for the exchange of data on Microsoft® WindowsTM based 
environments. The basis for OPC is the COM (Component Object Model) or DCOM (Distributed Component 
Object Model) specified by Microsoft. OPC is based on the client/server architecture, i.e. an OPC server 
makes its data available to others (OPC clients). DCOM also allows OPC data to be transported between 
different computers via the network, i.e. the OPC server and OPC client can run on different PCs. 

This M-Bus OPC server supports the following OPC specifications: 

• OPC Data Access Specifications Version 1.0
• OPC Data Access Specifications Version 2.0

mailto:info@mbs-software.de
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4. Installation of the software

If the autostart function of the CDROM drive is switched on, the installation program is started automatically 
after inserting the program CDROM.  

If the autostart function is not activated, please call up the "SETUP.EXE" program from the main directory of 
the CDROM for installation. 

Please follow the instructions of the installation program. 

After installation, the software is available in the start menu. 

If required, the software can also be copied to the Autostart folder to enable an automatic start after the 
operator logs in. In this case, the last saved project planning is automatically called up so that the required data 
is immediately available. 

program, go to Uninstalling: If you want to uninstall the 
"Add or Remove Programs" in the Windows Control Panel and uninstall the program. 

After installing the program, plug the supplied software protection plug (dongle) into a free USB port. 
The M-Bus OPC server is now ready for use. 

An OPC mini-client is installed with the M-Bus OPC server. This OPC mini-client can be used to easily test the 
OPC functionality of the M-Bus OPC server. The OPC mini-client is located in the MBS program directory. 

mailto:info@mbs-software.de
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4.1 FIRST STEPS AND SAMPLE CONFIGURATION 
 Once the M-Bus OPC server has been connected to the M-Bus via the RS232C interface using a level 
converter, start the M-Bus OPC server. 
Now create a new M-Bus: 

Set up this M-Bus, select the desired settings and confirm with "OK". 

The newly created M-Bus is now displayed in the main window. If another M-Bus is required, repeat the 
previous steps.

mailto:info@mbs-software.de
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The M-Bus is then read in. To do this, select the following menu: 

In the following dialog, select the desired settings and confirm with "OK". 

mailto:info@mbs-software.de
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The meters are then read in. Depending on the topology, this process may take some time. The meters found 
are displayed in the system tree and in the main window.  

Once the read-in process is complete, the following message appears in the status bar: "Meter read-in is 
complete!"

The M-Bus OPC server can be switched to "Activate polling" mode via the toolbar. The meter data points are now 
polled cyclically. The polling interval is set via the properties of the meter.  (See also: Meter properties dialog)

mailto:info@mbs-software.de
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5. The dialogs of the program

5.1 THE MAIN WINDOW

After starting the software, the program window appears.

Main windowSystem tree               Status bar                Toolbar 

System tree: 

In this screen, the connected M-Bus meters are displayed in a tree structure similar to the Windows file 
explorer.

Status bar: 
Displays the operating status of the M-Bus OPC server.

Toolbar: 
 The toolbar provides quick access to the most important program functions.

Main window: 

The main window provides a convenient overview of the connected devices and current meter values even 
without connected OPC clients.

mailto:info@mbs-software.de


 M-BUS OPC-SERVER - MANUAL   9MBS GmbH | Römerstraße 15 | 47809 Krefeld | Tel. +49 21 51 72 94-0 | info@mbs-software.de 

The columns of the main window display different specific information in the columns depending on 
whether "Bus" or "Meter" is selected. 

The program window in the "Bus" view.

The program window in the "Meter" view.

mailto:info@mbs-software.de
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 5.2 USER INTERFACE 

5.2.1 System tree, information about the communication status 

Successful communication. 

Communication uncertain. 

Communication disrupted. 

Data points read in and OK. 

Data points uncertain. 

Data points cannot be read. 

5.2.2 Status bar, standby display , tooltips 

This information line shows the ready status of the program. If the mouse pointer is moved over an entry in 
the toolbar or within the menus, brief information about the corresponding program function is displayed at 
this point.

5.2.3 Status bar, information about the communication status 

This information line can assume the following states: 

The program is in parameterization mode, communication to the M-Bus and OPC is deactivated. 

The program is in operating mode. 

The program is in operating mode and the data points are read out.

The program is in operating mode and the specified Meter is read. 

 The polling cycle is switched on and active. 

mailto:info@mbs-software.de
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5.3 THE TOOLBAR 
 The toolbar provides quick access to the most important program functions. The individual functions of the 
toolbar are described below. 

The following functions are available here for direct access: 

New document: 

Creates a new, empty project. 

Open: 

Opens an existing project from the hard disk. 

Save: 

Saves the current project to the hard disk. 

Import : 

Importing a project configuration in XML format.

Export: 
Exporting a project configuration in XML format. 

Read in all buses: 

Searches for devices on all connected serial interfaces. 

Read bus again: 

Searches for devices on the currently selected serial interface. 

Cancel import: 

Interrupts the search for new devices. 

Create new: 

Depending on the selected position in the tree, a new bus, a new device or a new data 
point can be created. 

Parameterization: 

Switches to configuration mode for editing the project planning. 

Activate polling: 

Switches on the cyclical polling of the Meter values (polling). 

Info about: 

Shows information on the program version. 

mailto:info@mbs-software.de
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5.4 THE MENUS OF THE M-BUS OPC SERVER 
5.4.1 The "File" menu 

5.4.1.1 New 

 creates an empty parameterization file (mbt file). 

5.4.1.2 Open 

 loads a parameterization file from the hard disk (mbt file). 

5.4.1.2 Saving 

 saves the current parameterization file to the hard disk (mbt file). 

5.4.1.3 Save as 

 saves the current parameterization file to the hard disk with the option of selecting a new file name (mbt 
file). 

5.4.1.4 Import 

Select this option to import a configuration in XML format. 

5.4.1.5 Export 

 Select this option to save a project in XML format. 

5.4.1.6 Exit 

 Exits the M-Bus OPC server. If clients are still connected to the OPC server, a warning message appears to 
draw attention to this status. In this case, the connected clients and then the M-Bus OPC server should be 
terminated first. 

mailto:info@mbs-software.de
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5.4.2 The "Edit" menu 

5.4.2.1 Create new 

 Depending on the position in the system tree, the new creation of: Bus, Meter or Data point. 

5.4.2.2 Delete 

 Depending on the position in the system tree, the deletion of: Bus, Meter or Data point. 

5.4.2.3 New read-in 

 New read-in optionally from: current bus or all buses. When reading in the meters, all data points of the 
meter are read in. 

5.4.2.4 Cancel read-in 

 Interrupts the search for new meters. 

5.4.2.5 Properties 

 Depending on the position in the system tree, the properties of: Bus, Meter or data point. 

5.4.3 The "View" menu 

5.4.3.1 Toolbar 

 Switches the display of the toolbar on or off. 

5.4.3.2 Status bar 

 Switches the display of the status bar on or off. 

mailto:info@mbs-software.de
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5.4.3.3 System tree 

 Switches the display of the system tree on or off. 

5.4.4 The "Mode" menu 

5.4.4.1 Parameterization 

 Switches to configuration mode for editing the project planning. 

5.4.4.2 Online 

 Switches on the cyclical polling of the Meter values (polling). 

5.4.4.3 Settings 

 Settings of the M-Bus OPC server 

5.4.4.4 Password protection 

 Allows you to enter an access password to prevent unauthorized changes to the parameterization. 

5.4.4.5 Logging 

 Switch on the logging function. Serial communication and the frames received can be recorded. The 
recorded data can be stored in a file or in the clipboard. After selecting "Output to file", the path and file 
name can be selected.  

Caution: 

This can generate large amounts of data. Example of a logging output: 

2012-02-14 07:39:06.249 -> -_-_-_-_-_-_-_-_-_-_-_-_-_ MBUS-Explorer Version 2.0.0.38 -_-_-_-_-_-_-_-_-_-_-
_-_-14.02.2012 07:39:06.686 -> COM1: ReadFrame: OK, 76 bytes 
14.02.2012 07:39:06.686 -> COM1: Updating counter 00510400, addr 1, frame 29, offset 197  
14.02.2012 07:39:06.686 -> COM1: more data follows  
14.02.2012 07:39:06.686 -> COM1/Bus1: reading counter 00510400, adr 1, frame 30, offset 204  
14.02.2012 07:39:07.374 -> COM1: ReadFrame: OK, 76 bytes  
14.02.2012 07:39:07.374 -> COM1: Updating counter 00510400, adr 1, frame 30, offset 204 

mailto:info@mbs-software.de
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5.5 "EDIT/PROPERTIES" DIALOG 
Depending on the position in the system tree, the properties of: Bus, meter or data point. 
• Bus

This is used to configure the serial interface to which an M-Bus level converter is connected. Any number.
of interfaces can be used.

• Meter

This is used to define the settings for the connected M-Bus meters.
• Data point

If you click on a data point in the main window, the properties of the data point are displayed.

By clicking with the right mouse button on the bus or meter, a selection menu appears in which the editing 
functions can be called up.  

This functionality is available in the main window for the data point. 

mailto:info@mbs-software.de
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5.5.1 Bus properties dialog 

The following properties can be defined here for a bus connection: 

Name: Specify the name of the serial interface (bus) to which the level converter is connected. This name is 
used as the first part of the three-level OPC address. 

Description: Informal text, here you can enter a free text to describe the bus if required. 

Number of meters: The number of meters connected to the M-Bus is displayed. 

Interface: Connection of the level converter. Select the serial interface to which the level converter is 
connected here. 

Search method: Wildcard, Sequential, Wildcard+Sequential, defines which search method(s) should be 
selected for automatically determining the device properties of the connected meters. 

Explanation of the search methods:

• Wildcard means searching with 'ffffffffff' on the bus, either several devices respond or only one. If there
are several devices, the wildcard search continues with the possible devices (e.g. 0fffffffff, 1fffffffff etc.)
until all possibilities have been tried.

• With a sequential search, all possible device numbers are scanned (i.e. a maximum of 250). However, this
may mean that not all devices are recognized and scanning takes longer.

mailto:info@mbs-software.de
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Baud rates supported on the M-Bus at the same time: 

 Select the baud rates supported on the bus here, the M-Bus standard allows different baud rates to be used 
on the same bus. 

Interface configuration: 

The RS232C handshake lines RTS and CTS can be configured here. 

5.5.2 Meter properties dialog 

Name: Specify a name here; this is used as the second part of the OPC tag. 

Description: If required, enter a free text to identify the Meter. 

Medium: Select the measured medium here, e.g. gas, water, etc. This entry is read from the meter during 
automatic reading and can no longer be changed. 

mailto:info@mbs-software.de
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Poll interval: The poll interval on the bus can be set here; the value set for the bus is used as the default. 

Important note: With older meters, it is possible that the meters may lose their content and possibly their 
configuration if the polling intervals are too high. Please read the description of the connected meters to find 
out whether there are any restrictions on the frequency of read requests. 

For all devices: This button can be used to adopt the poll interval for all meters on this bus. 

Identification number: Specify the identification number of the meter here; this entry is also read from the 
meter during automatic reading. 

M-Bus address: The M-Bus address is displayed here. When creating a meter manually, the M-Bus address 
can be set here.

Baud rate: Set the baud rate if required. This value is also set automatically during automatic reading. 

Communication active/inactive: If required, switch off the cyclical polling of the Meter here; communication 
is switched on as the default value. 

Manufacturer: Select the manufacturer of the meter here; this entry is set automatically during automatic 
reading. 

Polling via: Here you can select whether polling should take place via the identification number (secondary 
addressing) or via the M-Bus address (primary addressing). 

Init: Sending an SND_NKE command before polling. This setting is only available in primary addressing. If 
successfully received, an SND_NKE initializes the end device at connection level for receiving further 
telegrams. 

Parameterized data points:  The data points of the Meter can be edited here. 
 See also dialog: Data points/properties. 

mailto:info@mbs-software.de
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5.7 DATA POINT PROPERTIES DIALOG 

Name: Enter the name of the data point here. This is used as the third part of the OPC tag. During automatic 
reading, the data points are numbered consecutively according to the "DP-xxx" scheme (xxx=consecutive 
number within the Meter). 

Description: Enter a free description text here if required. 

Category: Select the data point category here. These entries correspond to those of the M-Bus standard. 

Data type: Select the data type via which the value is to be mapped to OPC. 

Status: This shows whether the value was successfully read during the last query. 

Identification number: The identification number of the meter to which the data point belongs is displayed 
here for information purposes.  

mailto:info@mbs-software.de
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Address: The address of the meter to which the data point belongs is displayed here for information 
purposes.  

Initial value: The initial value can be defined in this field. This value is transferred via OPC as long as no value 
has been read from the Meter. 

Factor: The scaling factor of the data point is defined here. 

Tarif: The tarif number can be specified here if required. 

Storage number: The storage number of the data point can be defined here if required. 

Note: For further information on the M-Bus data points, in particular on units, factors, tariff number and 
storage number, we recommend the documentation of the M-Bus Usergroup (available on the Internet at 
www.m-bus.com). 

Unit: The unit of the data point is defined here. After selecting "Set target unit", the selected unit can also be 
copied to other data points. To do this, the "Delete target unit" button changes to "Copy target unit". When 
the button is pressed, a new window opens in which the data points to which the unit is to be copied can be 
selected. The desired data points are selected and the copy action is started with the "OK" button. 

mailto:info@mbs-software.de
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5.8 "MODE/SETTINGS" DIALOG 

Basic settings for the M-Bus OPC server are made in this menu. These settings relate to the display, the 
communication behavior of the M-Bus and the behavior when starting and exiting the program.  

Remaining scan status display in status bar: A progress bar is displayed in the status bar, which provides 
information about the remaining time of the scanning process. 

Splash screen at startup: Display a splash screen. 

Minimize at startup: The program is automatically minimized at startup and displayed as an icon in the 
taskbar. 

mailto:info@mbs-software.de
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Close minimizes the application (exit via menu): The "Close button" in the program window minimizes the 
application. The application is then displayed as an icon in the taskbar. The application can be closed via the 
"File/Exit" menu. 

Selection menu for the behavior when exiting the program: 

The following options are offered: 

• Save project planning on exit
• Do not save project planning when exiting
• Ask before saving

Use manufacturer ID for addressing: The manufacturer ID supplied by the M-Bus device is used for 
addressing. 

ACK/request delay: ACK/request delay in ms. 

Pause between queries: Setting the pause time between two device queries. 

Pause for Siemens devices: Special query setting for Siemens devices. 

Number of permitted query errors: Setting of the permitted query errors. 

Permitted readout errors: Setting of the permitted readout errors. 

Readout errors also allowed for primary search: Allow readout errors also for the primary addressed search. 

Permitted frame timeouts: Set the number of permitted frame timeouts. 

Number of bytes per ser. Read: Setting of the bytes for serial reading. 

Waiting time after init telegram: Setting the waiting time after sending the initialization telegram. 

Skip first init telegram (SND_NKE): Skip the first initialization telegram when querying. 

Simple mode for Sontex device: Special mode for Sontex devices. 

mailto:info@mbs-software.de
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6. OPC addressing

The OPC tags used for addressing are generated according to the following scheme: 

busname.metername.datapointname 

The dot character is currently used as a separator. 

The following image shows a selection of OPC tags using the Mini OPC client supplied. 

Output window of the OPC Mini Client: 

mailto:info@mbs-software.de



